
MODULE 1 
ENHANCING 
IMAGES
Introduction
To effectively use imagery to analyze and solve problems, you need to be able to 

display and enhance imagery and interpret pixel values. In this module, you will 

create basemaps of the study area and explore the basic functionality of the Image 

Analysis window in ArcMap. You will enhance and display imagery in a variety of 

ways and interpret the results.



Scenarios in this module
•	 Displaying and enhancing Landsat imagery of the Chesapeake Bay
•	 Displaying and enhancing Landsat imagery of Las Vegas, Nevada
•	 On your own

Student worksheets
The student worksheet files can be found on the Maps and Data DVD.

Project 1: Chesapeake Bay student sheet
•	 File name: 01a_enhance_worksheet
•	 Location: \Student_Worksheets\01enhance

Project 2: Las Vegas student sheet
•	 File name: 01b_enhance_worksheet
•	 Location: \Student_Worksheets\01enhance
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PROJECT 1
Displaying and enhancing Landsat 
imagery of the Chesapeake Bay

Background
Landsat Thematic Mapper (TM) images consist of seven spectral bands with a spatial resolu-
tion of 30 meters for bands 1–5 and band 7. Band 6 is a thermal infrared band that has a spatial 
resolution of 120 meters. Table 1 provides information about these bands.

TABLE 1 DESCRIPTION OF LANDSAT SPECTRAL BANDS

Band Wavelength Micrometers
Resolution 
(meters)

Band focus (features most clearly identifiable in  
a band)

1 blue 0.45−0.52 30 Coastal water (has the most atmospheric scatter)

2 green 0.52−0.60 30 Vegetation

3 red 0.63−0.69 30 Chlorophyll absorption (monitors vegetation health)

4 near-infrared 0.76−0.90 30 Water discrimination (water appears very dark)

5 mid-infrared 1.55−1.75 30 Moisture content of vegetation and soil

6 thermal 10.40−12.50 120 Surface temperature, volcanic monitoring

7 far-inf`rared 2.08−2.35 30 Rock discrimination

The individual band images are stored using digital numbers (DN values) between 0 and 
255. For a single band, it is common to display the different numbers using shades of gray. 
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Most computer monitors are capable of displaying 256 distinct shades of gray. In bands 1–5  
and 7, the lower the value of the pixel in the grayscale image, the darker the pixel, and 
the lower the spectral reflectivity in that area. In band 6, lower pixel values and darker 
shades of gray approximately correspond to lower temperatures. Water, which absorbs 
near-infrared radiation, has a low reflectivity/digital number in band 4. Concrete, sand, and 
other man-made surfaces have high reflectivity in certain bands, and therefore have high 
digital numbers.

The purpose of image enhancement is to use different procedures to improve the visual appear-
ance of an image, making it easier to interpret. Image enhancement can occur via a number 
of methods. Each method tries to use the full range of shades of gray that can be displayed by 
the computer monitor. This is important because in many images the pixels have similar DN 
values and do not cover the full range of possible values. With the image displayed using the full 
range of brightness, differences can be more readily observed because they are amplified in the 
enhanced display.

Scenario/problem
Because visually interpreting Landsat images is important in many qualitative applica-
tions, your company has designated the first segment of the contract to understanding and 
enhancing grayscale Landsat images. The Chesapeake Bay Foundation (CBF) has asked for 
enhanced grayscale imagery it can use in articles and presentations to highlight different 
aspects of the bay.

Objectives
You have been asked to use Landsat imagery to do the following:
•	 Display the different bands of Landsat 5 data.
•	 Investigate histograms and their relationship to spectral reflectance.
•	 Use different enhancement techniques for grayscale imagery to highlight important features 

in the Chesapeake Bay.

Deliverables
We recommend the following deliverables for this project:
1.	 A map that displays and identifies the Chesapeake watershed, the study area, the rivers, and 

the highways.
2.	 A discussion of what bands to use to best show water, roads and highways, and different 

types of vegetation.
3.	 Histograms comparing reflectance values for bands 1–5 and 7.
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4.	 A document with three different enhanced images with their respective histograms and a 
written explanation of the enhancement techniques used.

The questions for this project are both quantitative and qualitative. They identify key points that 
should be addressed in your analysis and presentation.

Keeping track of where your data and results are located is always a challenge. In these projects, 
we give the path to access the data (current workspace) and the path to store the results (scratch 
workspace) in a footnote on each page. The directions will specify whether results should be 
placed in the results folder or the results geodatabase.

Examine the data
The next step in your workflow is to identify, collect, and examine the data for the Chesapeake 
Bay analysis. Here, we have identified and collected the data layers you will need. Explore 
the data to better understand both the raster and vector feature classes in this project. You 
can do this by right-clicking each feature class or raster within the geodatabase and clicking 
Item Description. This can be done in ArcMap using the Catalog window without actually 
adding the layers to the map document. The item description is a simple, standardized core 
description that contains a title, summary, tags, credits, and restrictions. If you want to more  
thoroughly access the metadata associated with each layer, you will need to perform the 
following steps:

1.	 On the Customize menu, click ArcMap Options.
2.	 Click the Metadata tab, and then select ISO 19139 Metadata Implementation Specifica-

tion from the drop-down menu.

You have to do this only once, and then it is set as the standard. Now formal metadata is sup-
ported in your item description. This allows you to view the spatial coordinate system, the reso-
lution of the data, and the attribute data in the ArcGIS metadata.

You are now ready to examine the metadata.

1.	 Start ArcMap. (For these exercises, the Getting Started dialog box is not needed. Select the check 

box at the bottom so it does not appear in the future.)

2.	 Connect to the geodatabase in the data folder. Remember that the path to the data folder is 

shown in the footnote.

3.	 Right-click rivers in the Catalog window and view Item Description.
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4.	 Open the landsat_may_2006 folder and double-click the L5015033_03320060504_MTL text file 

to access the metadata for the Landsat image.

Q1	 View the metadata for these features and complete the following chart on 
your worksheet.

Layer

Publication 
information: 
Who created 
the data?

Time period 
data is 
relevant

Spatial 
horizontal 
coordinate 
system Data type

Resolution 
for Rasters

L5015033_03320060504_B40

Rivers

Now that you have explored the available data, you are almost ready to begin your analysis. First 
you need to start a process summary, document your project, and set the project environments.

Organize and document your work
The following preliminary steps are essential to a successful geospatial analysis.

Examine the directory structure

In a geospatial project, you must carefully keep track of the data and your calculations. You 
will work with a number of different files, and it is important to keep them organized so you 
can easily find them. The best way to do this is to have a folder for your project that contains a 
data folder. For this project, the folder named \01enhance\project1_bay_enhance\bay_data_
enhance will be your project data folder. Make sure it is stored in a place where you have write 
access.

You can store your data inside the results folder. The results folder already contains an empty 
geodatabase named bay_results for this purpose. Save your map documents to the \01enhance\
project1_bay_enhance\bay_results_enhance folder.

Folder structure:
	 01enhance
			   project1_bay_enhance
				    bay_data_enhance
					     bay.gdb
					     landsat_may_2006
				    bay_results_enhance
					     bay_results.gdb
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Create a process summary

The process summary is simply a list of the steps you used to perform your analysis. We suggest 
using a simple text document for your process summary. Keep adding to it as you do your work 
to avoid forgetting any steps. The following list shows an example of the first few entries in a 
process summary:
1.	 Explore the data.
2.	 Produce a map of the Chesapeake Bay with the states and rivers labeled.
3.	 Display individual Landsat bands with histograms.

A process summary is essentially a work log. It will allow you to remember the steps in your 
data analysis at a later time or communicate them with others who might need to reproduce 
your work. When performing any sort of remote sensing or GIS analysis, you will often need to 
experiment to find the best methodology for completing a task. Be sure to revise your process 
summary when you are done with your analysis.

Document the map

You need to add descriptive properties to every map document you produce. You can use the 
same descriptive properties for each map document in the project or individualize the docu-
mentation from map to map.

1.	 On the File menu, click Map Document Properties. The Document Properties dialog box allows 

you to add a title, summary, description, author, credits, tags, and hyperlink base.

2.	 Click the pathnames check box, which makes ArcMap store relative pathnames to all your data 

sources. Storing relative pathnames allows ArcMap to automatically find all relevant data if you 

move the project folder to a new location or computer.

Set the environments

In GIS analysis, you will often gather data from several sources, and this data may be in differ-
ent coordinate systems and map projections. When using GIS to perform area calculations, you 
would like your result to be in familiar units, such as square miles or square kilometers. Data in 
an unprojected geographic coordinate system has units of decimal degrees, which is difficult to 
interpret. Thus, calculations will be more accurate if all the feature classes involved are in the 
same map projection. Fortunately, ArcMap can do much of this work for you if you set certain 
environment variables and data frame properties. In this section, you will learn how to make 
these settings. To display your data correctly, you will need to set the coordinate system for the 
data frame. When you add data with a defined coordinate system, ArcMap will automatically set 
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the data frame’s projection to match the data. If you add additional layers that have coordinate 
systems that differ from the data frame’s, they will automatically be reprojected on the fly to the 
data frame’s coordinate system.

1.	 On the View menu, click Data Frame Properties, and then click the Coordinate System tab. Set the 

map projection to Projected Coordinate Systems > UTM > WGS 1984 > Northern Hemisphere > 

WGS 1984 UTM Zone 18N.

2.	 On the Geoprocessing menu, click Environments. Remember : The environment settings apply to 

all the functions within the project. The analysis environment includes the workspace where the 

results will be placed and the extent, cell size, and coordinate system for the results.

3.	 By default, inputs and outputs are placed in your current workspace, but you can redirect the 

output to another workspace, such as your results folder.

a.	 Set the Current Workspace to \01enhance\project1_bay_enhance\bay_data_enhance.

b.	 Set the Scratch Workspace to \01enhance\project1_bay_enhance\bay_results_enhance\

bay_results.

4.	 For Output Coordinate System, select Same as Display.

5.	 Click OK and save the project as enhance_bay1.

Analysis
Once you have examined the data, completed the map documentation, and set the environ-
ments, you are ready to begin the analysis and complete the data displays you need to explore 
the problem. A good place to start any geospatial analysis is to produce a basemap to better 
understand the distribution of features in the geographic area you are studying. First, you will 
prepare a basemap of the Chesapeake Bay, labeling the states and rivers.

STEP 1: Create a basemap of the Chesapeake Bay

1.	 Create a basemap of the Chesapeake Bay by adding highways, rivers, states, and watershed from 

the bayfeatures dataset in the bay geodatabase. Highways and rivers have been clipped to the 

area near Washington, DC.

2.	 Make the Chesapeake Bay watershed hollow and label the states. Convert the state labels to 

annotations within the map so that they can be moved and properly placed.
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3.	 Symbolize the rivers by unique value using Name as the value field.

4.	 Add highways and import the highways layer file.

5.	 Make the study area 65% transparent.

6.	 Create a presentation-quality map using correct cartographic principles.

7.	 Save your map document to the bay_results_enhance folder.

8.	 Save the map document a second time as enhance_bay2. (When you save the map document again 

as enhance_bay2, it correctly saves the documentation, data frame projection, and environment 

settings. This saves you from having to redo these variables for subsequent deliverables.)

Q2	 What state has the most coastline on the Chesapeake Bay?

Q3	 Write a short description of the geography of the Chesapeake Bay.

Deliverable 1: A map that displays and identifies the Chesapeake watershed, the rivers, and the 
highways.

STEP 2: Investigate individual grayscale bands

1.	 Open the map document enhance_bay2 and go to Data View.

2.	 Remove all the layers except states. Symbolize the states as hollow.

3.	 Select all elements and remove the annotated labels.

4.	 Add L5015033_03320060504_B40 from the landsat_may_2006 folder in your data folder.

5.	 On the Windows menu, click Image Analysis to open the window.

6.	 Click the L5015033_03320060504_B40 image in the Image Analysis window and select the 

Background check box. This will remove the area that has no data.

7.	 Move the hollow states layer above the image.
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8.	 Explore the image. Activate the Go To XY tool on the Tools toolbar. Change the units to meters 

using the drop-down menu and enter X: 323168 and Y: 4305831. Click the Zoom To icon and zoom 

to the Washington, DC, area. Locate the following features:

•	 Washington Mall

•	 Lincoln Memorial Reflecting Pool

•	 Jefferson Memorial

You can add different basemaps using the Add Data button on the Standard toolbar. There are 
a variety of basemaps to choose from (such as World imagery). Use the Effects toolbar to swipe 
or flicker to compare the Landsat image to the basemap imagery.

Q4	 What features can you identify?

Q5	 What is the smallest feature you can identify? Why?
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Landsat TM cannot detect small objects such as trees or individual houses. It can, however, 
detect larger types of land use, such as forest, agriculture, or urban areas. The “on the ground” 
resolution of each pixel is 30 × 30 meters (m), which means features smaller than 30 m, such 
as individual houses and cars, can’t be resolved in these images. Although images with higher 
resolution are often available, they are very difficult to use for examining medium to large areas 
because of their very large file size. Landsat TM images are ideal for this purpose because of 
their lower resolution and smaller file size.

Images can be enhanced by using the tools available on the Image Analysis Display panel. This 
panel can be activated from the Windows menu and has the following tools:
•	 Contrast: Adjusts the difference between the darkest and lightest colors.
•	 Brightness: Increases the overall brightness of the image—for example, making dark colors 

lighter and light colors whiter.
•	 Transparency: Allows you to make a raster layer partially transparent.
•	 DRA (Dynamic Range Adjustment): Allows you to see features in some images or raster 

datasets, or to distinguish them more easily from their surroundings. In many cases, you can 
get the enhancement you need by adjusting the pixel values within the portion of the raster 
displayed and not using all the pixels in the full raster dataset.

•	 Background: Uses values to set the display background color.

You used the Background tool when you selected the Background check box and set the no-data 
values to no color.

Stay zoomed to Washington, DC, and experiment with the enhancement tools. To reset the 
image to its original value, just click the icon to the left of the tools.

9.	 Click the band and move the Contrast slider back and forth.

Q6	 What happens to the image when you change the contrast?

10.	 Reset the Contrast tool and move the Brightness slider back and forth.

Q7	 What happens to the image when you change the brightness?
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11.	 Reset the Brightness tool and move the Transparency slider back and forth.

Q8	 What happens to the image when you change the transparency?

12.	 Zoom to the Washington Mall and select the DRA check box.

Q9	 When you select the DRA check box, what happens to the features around 
the Lincoln and Jefferson Memorials?

13.	 Clear the Background and DRA check boxes.

14.	 �Add all the bands from the Landsat folder except L5015033_03320060504_B60. Arrange the 

bands in numerical order (B10 = band 1, B20 = band 2, and so on).

15.	 Add AOI (areas of interest) from the bayfeatures dataset.

16.	 Make AOI hollow and label the features.

17.	 �Zoom to AOI area 7. Start with the first Landsat band (B10) and turn the different bands on  

and off.

Q10	 In which band are the bridges and streets more visible?

Q11	 Which band best delineates water?

18.	 Zoom to AOI area 4.

Q12	 Which band best distinguishes different types of vegetation?

Deliverable 2: A discussion of which bands best show water, roads and highways, and different 
vegetation varieties.
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STEP 3: Match DN to land features

1.	 Highlight all the bands in the Image Analysis Display panel, and then click Background to set the 

background values to no color.

Remember: We are not adding L5015033_03320060504_B60 because L5015033_ 
03320060504_B60 shows emitted thermal radiation and not spectral reflectance.

In Landsat imagery, the attribute table contains a Value field, which represents the amount of 
reflected light (given as the DN), and a Count field, which gives the number of pixels that have 
that value. A raster attribute table must be calculated for each band before it is viewed. If a 
Landsat band has already been viewed, the attribute table has already been calculated.

If the attribute table has not been calculated, click the band and go to Properties > Symbology > 
Unique Values. The software will ask whether you want to build an attribute table. Click Yes and 
close the menu. Now you can open the attribute table for the band. Change the classification 
back to Stretched in the Show window to change the view back to gray. Click OK. An attribute 
table must be calculated for each of the six bands.
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The digital numbers shown in the attribute table describe the brightness of features in differ-
ent bands. Remember, in the bands you have viewed, the brighter (more reflective) a feature is, 
the higher its digital number. Consequently, if you create histograms that plot the frequency of 
the various digital numbers, different scenes will yield very different histograms. For instance, 
if you have a scene with a lot of water, the histogram for band 4 will have many pixels with low 
digital numbers (toward the left side of the histogram) because water is not very reflective in 
the near-infrared. However, a scene with significant forest cover would have a band 4 histogram 
with many pixels having high digital numbers because vegetation is very reflective in this band.

2.	 You can analyze the bands by identifying and selecting features by their digital number (reflectiv-

ity). For example, if you use the Identify tool you can see that water is usually in the range of 8–19 

in band 4 (B40) rasters.

For the rest of the project, the Landsat bands will be referred to as bands 1–5 and 7.

3.	 If you select these values in the attribute table, pixels with these values will be highlighted in the 

image. Right-click Count in the attribute table to sort the table by ascending or descending values.

4.	 You can also use the Identify tool to click individual pixels that you know represent the land 

feature you are trying to identify. This will give you a starting value to investigate. The following 

image shows an example of selecting the DN values for water.
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Q13	 Using the Identify tool, complete the following chart on your worksheet.

Range of digital numbers

Band 1 Band 2 Band 3 Band 4 Band 5 Band 7

water

STEP 4: Use the Pixel Inspector

The Pixel Inspector tool is used to view the pixel values of your raster dataset. It is different from 
the Identify tool. The Pixel Inspector will show an array of pixels instead of a single pixel value. 
It is useful in examining areas where pixel values change abruptly. The Pixel Inspector tool has 
to be added to a toolbar.

1.	 In ArcMap, go to Customize > Customize Mode > Commands > Categories > Raster.

2.	 From the Commands list, drag the Pixel Inspector onto any toolbar.

3.	 Click Close.

Once again, a good place to look at different pixel values is the Washington, DC, National  
Mall area.

4.	 Zoom to the National Mall area.
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5.	 When you click a pixel with the Pixel Inspector, a window opens with the pixel value displayed 

in the upper-left corner. The pixel value changes as you pick other areas. The query area is also 

shown as a grid in another display window.

Q14	 How do the values of the pixels change as you move from water to land?

Q15	 Do the pixel values change as you go over the bridges going into DC?

6.	 Save your map document to your results folder.

7.	 Save the map document again as enhance_bay3.
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STEP 5: �Create frequency histograms and an all band image 
frequency histogram

Frequency histograms provide another way to explore the reflectivity distribution of the bands, 
using a graph showing the variation in each band’s reflectivity. A frequency histogram shows 
the values of the pixels (x-axis) in a raster plotted versus the number of pixels with that value 
(the frequency) on the y-axis. For example, as mentioned earlier, in band 4 low reflectivities, or 
values, are an indication of water, and high values indicate features with high reflectivity (e.g., 
concrete, sand).

1.	 Open the map document enhance_bay3.

2.	 In the Image Analysis window, clear the Background check box for all bands.

3.	 On the View menu, go to Graphs > Create Graph.

a.	 Create a vertical bar graph of L5015033_03320060504_B40.

b.	 The value field is Count.

c.	 Expand the graph so that you can read the full x- and y-axis values.

Q16	 What is the total number of pixels in the image?

Hint: You might want to open the attribute table. Remember, you can right-click Count, and then 
click Statistics.

Q17	 How many pixels have a DN of 100?

Q18	 How many pixels have a DN of approximately 10?

Q19	 How would you describe the graph?
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Q20	 What does the large number of pixels with a DN of 0 represent?

Now that you understand the basics of a frequency histogram, you need to make a composite 
histogram showing all six nonthermal Landsat TM bands.

4.	 Close the practice graph for band 4 and go to View Graph > Manage and delete the practice 

graph. You are now ready to graph the frequency histogram for each band.

You do not want to graph the background values. Open the attribute table and select the value 0, 
which is the background value. Switch the selection to select the other values. This has to be 
done for each band or every time you graph a new series.

Do this procedure for each band before you start making the histograms.

5.	 On the View menu, click Create Graph. Create a vertical bar graph of band 1 with the following 

properties:

a.	 Set the Value field to Count.

b.	 For color, click Custom and choose a color appropriate to the band. For band 1, select blue.

c.	 The X label field should be Value.

d.	 Click Next, and then click the option that says, “Show only selected features/records on the 

graph.”

e.	 Click Back, and then click Add a New Series. Graph band 2. Pick an appropriate color. Do 

not forget to exclude the background values by showing only the selected features.

f.	 Repeat steps a–e for the other bands. Hint: At the bottom of the Graph window, you will see 

tabs for the graph for each band. If you click the tab once, you can change its name. Turn on 

the 3D option.

g.	 Click Finish.

h.	 Right-click the title to access Advanced Properties.

i.	 Under Advanced Properties, click Axis/Left Axis and change the maximum to 4,000,000.
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Q21	 Which bands have histograms with bimodal distribution?

Q22	 Which band has the most compact distribution of reflectance?

Q23	 Which band has the broadest distribution of reflectance?

6.	 Save your map document to your results folder.

7.	 Save the map document again as enhance_bay4.

Deliverable 3: Histogram chart comparing reflectance values for bands 1–5 and 7.

STEP 6: Enhance images

Image enhancement involves procedures that improve the appearance or interpretability of an 
image. As previously stated, a single image (band) is visualized in shades of gray, ranging from 
black (0) to white (255). To produce an image that has an optimal contrast, the full range of 
values from 0 to 255 should be used. There are various methods for contrast enhancement. In 
this exercise, you will look at three of these methods. In each of these methods, changes are not 
made to the actual data, but only to the way in which the values in the image are mapped to the 
values of the display.

The default method in ArcMap is the two standard deviations stretch, and it is used to brighten 
raster images. The minimum-maximum stretch is used when you need to display an image with 
a narrow range of pixel values. Unlike the previous two methods, the histogram equalization 
stretch lets you control the range of values displayed. These techniques are generally referred to 
as “stretching” an image.

1.	 Open the map document enhance_bay4.

2.	 Delete the graph.

3.	 Clear all selections.

4.	 Remove all layers except band4.
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5.	 Right-click band4 and go to Properties > Symbology. The classification type is stretched, and you 

can see the default type is Standard Deviations with an n-value of 2.

6.	 Click the Histograms button, and the histogram will be displayed. The gray values are the original 

pixel values, and the purple values are the “displayed” values after the stretch. The line on the 

histogram shows the relationship between the input values and the output values. A straight line 

represents a linear stretch, and a curved line represents a nonlinear stretch.

Q24	 Describe how the pixels are distributed after the standard deviation stretch.

Q25	 Explain the initial spike on the left side of the graph.

If you eliminate the background value of 0, the graph represents the distribution of spectral 
reflectance values in the image more accurately.

7.	 Remove band4 and add clip_band4 from the bay geodatabase.

Q26	 How does clip_band4 look different from band4?

8.	 Look at the histogram again.

Q27	 Why does the histogram look different?

Q28	 What is the minimum value of the image?
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9.	 Capture a screen shot of the image and the histogram using either the Print Screen key on the 

keyboard or any available image capture software. Insert both images into your document.

10.	 �The preceding histogram used the standard deviation stretch. Repeat directions 8 and 9 and 

select the histogram equalization stretch with clip_band4. 

Be sure to click Apply when you apply the histogram equalization stretch.

Q29	 How are the pixels distributed when a histogram equalization stretch is 
used?



23

1

MAKING  

SPATIAL 

DECISIONS  

USING GIS 

AND REMOTE 

SENSING

ENHANCING 

IMAGES

	 DATA (Current Workspace)	 \01enhance\project1_bay_enhance\bay_data_enhance
	 RESULTS (Scratch Workspace)	 \01enhance\project1_bay_enhance\bay_results_enhance

11.	 Capture a screen shot of the image and the histogram. Insert both into your document.

12.	 �Repeat directions 8 and 9 for a minimum-maximum stretch with clip_band4. In this 

stretch, you have to set the minimum and maximum values manually. Click the small box 

on the x-axis and drag it either to the origin or the lowest pixel value you want to include. 

This sets the minimum. Now click the small box at the top and drag it to the highest pixel 

value you want to include. This sets the maximum. When you examine the histogram, you 

will see that the majority of the pixels are in the middle. Very few pixels have the mini-

mum or maximum values. It is common practice in a minimum-maximum stretch to cut 

off the tails of the distribution by putting them outside the maximum and minimum values 

you have chosen.

13.	 Capture a screen shot of the image and the histogram. Insert both into your document.

Q30	 Compare the appearance of an image with a histogram equalization 
stretch to an image with standard deviation or minimum-maximum stretch.

14.	 Save your map document to your results folder.

Deliverable 4: A document with the three different enhanced images with their respective histo-
grams and a written comparison of the enhancement techniques.
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PROJECT 2
Displaying and enhancing Landsat 
imagery of Las Vegas, Nevada 

Scenario/problem
Visually interpreting Landsat images is important in many qualitative applications. PtD (Protect 
the Desert) has designated the first segment of the contract to understanding and enhancing 
grayscale Landsat TM images. PtD has asked for enhanced grayscale imagery that can be used 
in articles and presentations to highlight different aspects of the city of Las Vegas.

Objectives
You have been asked to use Landsat TM imagery to do the following:
•	 Display the different bands of Landsat TM data.
•	 Investigate histograms and their relationship to spectral reflectance.
•	 Use different enhancement techniques for grayscale imagery to highlight important features 

of Las Vegas.
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Deliverables
We recommend the following deliverables for this project:
1.	 A map that identifies Las Vegas, the study area, the rivers, and the highways.
2.	 A discussion of what bands to use to best show water, roads and highways, and different 

varieties of vegetation.
3.	 Histograms comparing reflectance values for bands 1–5 and 7.
4.	 A document with three different enhanced images with their respective histograms and a 

written explanation of the enhancement techniques used.

The questions for this project are both quantitative and qualitative. They identify key points that 
should be addressed in your analysis and presentation.

Keeping track of where your data and results are located is always a challenge. In this project, 
we give the path to access the data (current workspace) and the path to store the results (scratch 
workspace) in a footnote on each page. The directions will specify whether the results go in the 
results folder or the results geodatabase.

Examine the data
The data for this project is stored in the folder \01enhance\project2_vegas_enhance\
vegas_data_enhance.

View the item description and ArcGIS metadata to investigate the data. The chart helps you 
organize this information.

Q1	 Investigate the metadata and complete the following chart on your 
worksheet.

Layer

Publication 
information: Who 
created the data?

Time period data 
is relevant

Spatial horizontal 
coordinate 
system Data type

Resolution for 
rasters

Landsat

Urban
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Organize and document your work
Be sure to refer to project 1 and your process summary.

1.	 Set up the proper directory structure.

2.	 Create a process summary.

3.	 Document the map.

4.	 Set the environments on the Geoprocessing menu:

a.	 Data Frame Coordinate System to Projected Coordinate Systems > UTM > WGS 1984 > 

Northern Hemisphere > WGS 1984 UTM Zone 11N.

b.	 Current Workspace to \01enhance\project2_vegas_enhance\vegas_data_enhance.

c.	 Scratch Workspace to \01enhance\project2_vegas_enhance\vegas_results_enhance.

d.	 Output Coordinate System to Same as Display.

Analysis
An important first step in geospatial analysis is to develop a basemap of your study area.

STEP 1: �Create a basemap of Las Vegas, the study area, the rivers, 
and the highways

Deliverable 1: A map that identifies Las Vegas, the study area, the rivers, and the highways.

Q2	 Write a short description of the geography of Las Vegas and the 
surrounding area.

STEP 2: �Investigate individual grayscale bands in the Image 
Analysis window

1.	 Add L5039035_03520060512_B40 from your data folder and answer the following questions.

Q3	 What features can you identify in this Landsat scene?



2

MAKING  

SPATIAL 

DECISIONS  

USING GIS 

AND REMOTE 

SENSING

ENHANCING 

IMAGES

27	 DATA (Current Workspace)	 \01enhance\project2_vegas_enhance\vegas_data_enhance
	 RESULTS (Scratch Workspace)	 \01enhance\project2_vegas_enhance\vegas_results_enhance

Q4	 What is the smallest feature you can identify? Why?

Remember: You can add an imagery basemap and use the Effects toolbar to swipe or flicker to 
compare the Landsat imagery to aerial imagery.

2.	 Add AOI from your data folder and zoom to AOI 1.

Q5	 When you select the DRA check box in the Image Analysis window, what 
happens to the features of the airport?

3.	 Add bands 1–3, 5, and 7 (B10, B20, B30, B50, and B70). Arrange the bands in numerical order.

4.	 Zoom to AOI 5.

Q6	 In which band are the streets most visible?

5.	 Zoom to AOI area 4.

Q7	 Which band best delineates water?

6.	 Zoom to AOI area 1.

Q8	 Which band distinguishes different types of vegetation?

Deliverable 2: A discussion of what bands to use to best show water, roads and highways, and 
different vegetation varieties.

STEP 3: Match DN to land features

Q9	 Select values representing water in the attribute table, and those values 
will be highlighted in the image. Using this technique complete the 
following chart on your worksheet.

Range of digital numbers

Band 1 Band 2 Band 3 Band 4

water
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Q10	 Using the XY icon and the coordinates given below, locate McCarran 
International Airport. Use the Pixel Inspector to show an array of pixels. 
Examine the different features of the airport. How do the pixel values 
change?

X: –12819032		 Y: 4311863

STEP 4: �Create frequency histograms and an all band image 
frequency histogram

1.	 Create a histogram graph of L5039035_03520060512_B40.

Q11	 What is the total number of pixels in the image?

Q12	 How many pixels have a DN of 100?

Q13	 How many pixels have a DN of approximately 20?

Q14	 How would you describe the graph?

Q15	 What does the large number of pixels with a DN of 0 represent?

2.	 Make a composite histogram showing all Landsat bands except band 6.

Q16	 Which bands have bimodal histograms?

Q17	 Which band has the most condensed distribution of reflectance?

Q18	 Which band has the broadest distribution of reflectance?

Deliverable 3: Histograms comparing reflectance values for bands 1–5 and 7.
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STEP 5: Enhance images

1.	 Using L5039035_03520060512_B40, answer the following questions.

Q19	 Describe how the pixels are distributed after the standard deviation 
stretch.

Q20	 Explain the initial spike on the left side of the graph.

2.	 Using clip_band4, answer the following questions.

Q21	 How does clip_band4 look different from band4?

Q22	 Why does the histogram look different?

Q23	 How are the pixels distributed when a histogram equalization stretch is 
used?

Q24	 Compare the appearance of an image where a histogram equalization 
stretch has been applied to an image where a standard deviation or 
minimum-maximum stretch has been applied.

Q25	 Compare the all band frequency histogram from the Chesapeake Bay to the 
all band frequency histogram of Las Vegas and the surrounding area. What 
does the histogram tell you about the land features?

Deliverable 4: A document with three different enhanced images with their respective histo-
grams and a written explanation of the enhancement techniques used.
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PROJECT 3
On your own

Scenario/problem
You have worked through a guided project on Landsat TM satellite imagery for the Chesapeake 
Bay and repeated the analysis for Las Vegas. In this project, you will reinforce your skills by 
researching and analyzing a similar scenario entirely on your own. First, you must identify your 
study area and acquire the data for your analysis. You may want to study a local area. Refer to 
appendix A for directions on how to download your satellite imagery.

Research
Research the problem and answer the following questions:
1.	 What is the area of study?
2.	 What is the problem you are going to study?
3.	 What data is available?
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Obtain the data
Do you have access to baseline data? Data and Maps for ArcGIS at http://www.esri.com/data/

data-maps provides many of the layers of data that are needed for project work. Be sure to pay 
particular attention to the source of data and get the latest version. You can obtain data from 
the following sources:
•	 USGS Globalization Viewer at http://glovis.usgs.gov: Access to multiple sets of EROS  

satellite and aerial imagery.
•	 Census 2000 TIGER/Line Data at http://www.esri.com/tiger: Access to Census 2000 line data.
•	 Geospatial One-Stop at http://geo.data.gov: Web-based geospatial resources.
•	 The National Atlas at http://www.nationalatlas.gov: A range of products and geographic infor-

mation about the United States.
•	 The National Map at http://nationalmap.gov/viewer.html: Data includes elevation, land cover, 

and topographic maps.

Workflow
After researching the problem and obtaining the data, you should do the following:

1.	 Write a brief scenario.

2.	 State the problem.

3.	 Define the deliverables.

4.	 Examine the metadata.

5.	 Set the directory structure, start your process summary, and document the map.

6.	 Decide what you need for the data frame coordinate system and the environments.

a.	 What is the best projection for your work?

b.	 Do you need to set a cell size or mask?

7.	 Start your analysis.

8.	 Prepare your presentation and deliverables.

9.	 Always remember to document your work in a process summary.


